Word to Flash Brochure
Create Amazing Page-flipping eBooks with DOCs

User Documentation

Note: This product is distributed on a ‘try-before-you-buy’ basis. All features described in this
documentation are enabled. The unregistered version will be added a demo watermark.

About Word to Flash Brochure

If you want to show your Word Documents or OpenOffice Documents in a fresh and popular way,
converting DOCs to Page-flipping eBooks could be a good choice.

Flip books, no longer simple illustrated books for children, but also refer to the e-books which
combine page-flipping effect with electronic technology. This brand new publishing mode is
changing the way how the 'common' people will receive and view information. Normally by just
clicking the page on your computer screen, then you can flip and read the pages as reading real
ones. It looks really innovative and you can use it for your presentation.

And program Word to Flash Brochure is powerful enough to convert your DOCs to such kind of
eBooks with ease.

Word to Flash Brochure is flexible software to convert Microsoft Word documents or OpenOffice
documents to stunning page-flipping eBooks. The program can be used for all levels of users
without any programming knowledge needed. It will perfectly integrate your Word or OpenOffice
pages with life-like page turning effect into a new look eBook to be published, emailed, stored as
standalone EXE format or even with burned to CD.

With using Word to Flash Brochure, you can build your style eBooks using the dozens of preset
templates and adjust more than 50 kinds of settings yourself. You are able to use your favorite
background images, sounds, titles, exe logos, you can control book size, font, font and tool bar
buttons, you can even choose a hard or soft cover, right to left flipping and auto flipping to
present your DOCs in an interactive way.

After designing style for your page-flipping eBooks, you can choose a proper way to output:
"HTML" is for publishing online, "ZIP" can be much easier for emailing, "EXE" is an intergraded
format for quickly viewing, "Burn to CD" to output your digital books directly on CD-ROM.
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Detail features:

® Convert Microsoft Word documents to page-flipping eBooks.
® Convert OpenOffice documents to page-flipping eBooks.
® Output in 4 different formats: HTML, EXE, Zip and Burn to CD.
HTML allows you to upload to a website to be viewed online.
EXE and Zip allow you to send to your user by email to be viewed on their computer.
Burn to CD allows you to burn to disk so you can send out with physical media.
® Make a Mobile Version at the same time.
® Define your language for flash.
® Preview the output effect instantly.
® Provide multiple templates (default provided or download from website).
® Select render engine to output higher quality page-flipping ebook.
® Define mobile version quality.
® Import bookmarks (outline) with Word, and edit them manually.
® Import text so that text is searchable, define the minimum search characters.
® Set eBook size, choose landscape or portrait.
® Add password to protect your page-flipping eBook.
® Define titles, keywords and other metadata.
® Add Google Analytics Support.
® Define titles, icon, window size for EXE page-flipping eBooks.
® Define eBook margin size.
® Insert background music either for continuous play (loop) or for a set duration.
® Set background color and image.
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® Set eBook reading from right to left (for Right-to-Left languages such as Arabic).
® Choose hard cover for eBooks.

® Set page-flipping to manual or automatic.

® Set permissions for downloading, printing, sharing, Home button and more.

® Set colors and position (Top/Bottom) for toolbar.

® Set scale for zoom-in function.

® Set control bars to "show" or "hide" in full screen.

® Set the bookmark panel to show on left or right side.

® Set links to open in same or new window.

® Save and Load your project.

® Export and save settings for future use.

Using Word to Flash Brochure

Word to Flash Brochurecan be started either by launching the application via the desktop short cut, or
directly from Windows Explorer. Start the program, you will see the below initial window:
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The file in the processing interface is an example file.

There are some main interfaces you will see while using Flip Word as below shows: Application Options,
Import Word, Template Settings, Language Option and Output. You can enter into each page to get clear
instructions for every detail option.

I. Application Options Interface

1. Render Engine Option

Word to Flash Brochure provides 3 different render engines for you to create higher quality page-
flipping eBooks, click "Options->Application Options" to enter into "Render Engine" interface:
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@ Cptions |

Render Engine | Create Mobile Version

Pleaze selecte a render engine for the conversion

@ SWF
4

(7 GPL Ghostscript Dowload Ghostscript

() Inner Library

SWF: Much legible characters, smaller output size
GPL Ghostscript: Higher color transfer quality

Inner Library: Faster convert speed

SWEF: Much legible characters, smaller output size
GPL Ghostscript: Higher color transfer quality
Inner Library: Faster convert speed

(Change option when Word imported failed)

2. Create Mobile Version Option

Five types of "Quality And Size":

Pages Quality and Size

Quality And Size:

High quality large file size
Medium quality medium file size
Lowe quality small file size
Lower quality smaller file size

High values
LY but require m
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Il. Import Word Interface:

@] Import Word [

Source WORD Flie

Erowse.. l[ Qpen it l

The Page Ranges to Import Watermark
@ Al pages ,.F.‘" ” Place a custom text or image
() Custom range: Example:1,3,5,9-21 "‘7; Watermark(Stamp) to the file(s)
Quickly import (Only import 10 pages to initial preview) Set Watermark
Page Quality
Quality And Size: [High quality large file size v]

2 High values produce better page quality but require more disk space and more time to download.

Import bookmark Import links ["|Enable search

Import Now

Panel Description:

1. Source WORD File

Browse..

Click this icon to open the Word file you want to convert;

Open it
View content of added Word file to clarify before converting.

2. The Page Ranges to Import
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@ All pages o
Convert all pages to page-flipping eBooks;

(@ Custom range: 2-5 Example:1,3,5,9-21
Convert a range pages to eBook;

Quickly import {(Only import 10 pages to initial preview) . . .
Preview applied effect on first 10.

3. Watermark

Add image or text watermark to flipping pages.

[7] Applying Watermark Check this option first to choose default stamps or add new ones:

) 2dd Text wotermare
& Add Text Watermark

Text ame
Name:  Text Watermark

Text  Page-figpng eBack Macre: =
Text Propertes

Eonti | pietvesca. 7] [FlEmbedded Font
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Text Layout
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Edit / =
Add text stamp e -

Add image stamp. )4 ims: Wk

Page-flipping eBook

£

Add Image Watermark
Delete Image Hame
Name:  Image Viatermark

- | B

Move up —

ot [T S =
Image Effect
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Move down
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4. Page Quality

There are five types of "Quality And Size":

High quality large file size -

Higher quality larger file size

Low quality small file size
Lower quality smaller file size

5. Other Options

[¥] Import bockmark ) . . . . o
If your WORD file contains bookmarks, check this option to use in output page-flipping

eBook;

Impart links | £ v our Word file has links, check this to enable in flipbook;

Enable search . . . o .
V] Check this option to enable search functionality in created flipbook.

At last, click

icon to enter into template setting interface.
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lll. Template Settings Interface:

;‘ ;!P_”. '. e e

| B Comeen Optiors Help

B W S Wy

@pmlmn (3 apply Change  *. Convert To Flipping Book

Design Setng | Bookmark

Tergsates www.FipBulder.com  Papes: _ 6
if Flom - H k4
i ]

Plesse rustamine e A template here

| [ BBock:
Sock Tite v FigBul...
i Blook: Frame Ear H
Pl e fhe ook b comnber | Tew
Egeok Propartizes

Features;

Pagk Wiath %1
Page Heght 1A
Tap Margn )
St Margn 1
Left Margn &
Right Margn &0
Flarsh Window Color 000000
Page Background Coler [l
Biage Shadow

Left page Shadow e
Faght page Shadow ]
Page Shadow Opacty |1

E8ackpround Corfig
ElBachground Calor
Gradant Color & Bowasans
Gradient Coior 8 Elowasasas
Gradent gl ]
ElBackground

Outer Background Fie
Badwround position - Scale o £t
Irnes Backprourd Fie C:Vrograslh . -

Tool Bar
ES |ToolEar setongs.

The program provides three different templates at present: Classical, Float and Spread.
Each template contains some unique settings, the below instructions will show you details.

The design setting interface contains below main parts:
Choose Template

Book

Sound

Tool Bar

Initial Show

Bookmark

Language

Security Settings

Panel Description:
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1. Choose Template
Templates

‘ ﬂmassical ‘H E/]%

Please customise the flash template here

ﬁ Classical ‘E|

Click icon to select templates from below interface:
[ ] setect 8 Template : "]
Chaoss 3 fiphook templete here, (Double-Cic o e 5 guck sekechon )
W More and e leplater will be proveded n fuiune.)
(it More Themes Onie
Tempiadey
|
B s
| B roet
|| m& Sgread .
| N
|
|
1 1
|
|
! L]
!
|
|
|
||
| |
|
|
¥

|
| | = .

[ metuwn > Goaed |
[ - — —= E— E— B ——— = — B T . ——

Click this icon is to save current settings as a TXT file for later uses;

= Click this icon is to import stored setting file at once.
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2. Book Panel

ElBook
Book Title www . FlipB. ..
Hide Book Frame Bar Mo
Retain the book to center (Mo

HEook Propartions
Top Margin 10
Bottom Margin 10
Left Marain a0
Right Margin 60
Flash Window Color M0x021425

Page Background Color | ] 0ucffAFff
EHPage Shadow

HBackground Config
Right To Left Mo
Hard Cover Mo
Flipping Time 0.6

(1) Book Title (only can be set in Float Template)

| Book Tite

Customize book title for showing on the top of your flipbook.

(2) Hide Book Frame Bar
| Hide Book Frame Bar es |

If don’t want to show the book frame bar, choose “Yes” in this option.

(3) Retain the book to center

| Retain the book to center [Yes Rd

If you select “No” in this option, the eBook will be shown on the right-side. This setting is for embedding
special background image, such as advertisement or company log.
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(4) Book Proportions

BiBoak Proportons
Page Width 595
Page Haight 842

Width

Please note that the values are not fixed in pixels or inches, they just represent a ratio for "Page Width:
Page Height", and the book size will be changed depend on your Explorer Window Size.

(5) Book Margin

A. Book Margin (set in Classical Template):

[ BockMargn ) |

"Book Margin" refers to the distance between the book and the toolbar.

B. Top/ Bottom/ Left/ Right Margin (set in Float/ Spread Template):
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~) Bottom

(6) Flash Window Color

J0x2E3...| d

| Flash Window Color |

This color will be applied on all flash windows, such as the book window, "Help" window, "Print" window
and so on.

(7) Page Background Color

Page Background Color | EJOXFFF.... |

I |

When load pages, or if the page number of your WORD file is odd, then the page (the last page) will show
with the "Page Background Color".
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_(8) Page Shadow

[ElPage Shadow |
Left page Shadow | 100
Right page Shadow |55
Page Shadow Opadity |1

Left page Shadow
g

| Right page Shadow|
The value also takes the value of Book Proportions as reference, and the value interval of "Page Shadow
Opacity" is "0~1", the larger value refers to the deeper shadow color.

(9) Background Config
A. Background Color:

~Gradient Color A
. 4

Gradient Color B7™ |
Define background for your flipbook with gradient color or pure color (the same color for "Gradient Color
A" and "Gradient Color B"). Gradient Angle is the angle between the two colors.

B. B_acl_<grou_nd Image setting in Classical and Spread templates:
— !ma-.:: PR 2
| Image position Fil

Click the icon "=2I" to choose background image from your computer, and there are 11 kinds of "Image
Position" for you to choose: Scale to fit, Fill, Top Left, Top Center, Top Right, Middle Left, Middle Center,
Middle Right, Bottom Left, Bottom Center and Bottom Right.
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C. Background Image setting in Float template:
[ | Obsckground image | |

Inner background image to show special information, such as advertisement or company logo, etc. There
are also 11 kinds of "Image Position" for you to choose: Scale to fit, Fill, Top Left, Top Center, Top Right,
Middle Left, Middle Center, Middle Right, Bottom Left, Bottom Center and Bottom Right.

(10) Right to Left
If the language of your file is read from right to left (such as Arabic), then choose "Yes" in "Right to Left"

option:
|  RightTolLeft Yes

(11) Hard Cover
If you want create hard cover effect (a book bound with rigid protective covers) for your flipbook, choose
"Yes" in "Hard Cover" option:

: Hard Cover |Yes
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(12) Flipping time
Sets page flipping time in seconds according to your needs. (Recommended second value is 0.6):
Flipping Time 0.6

3. Sound Panel

Hsound
Enable Sound Enable

| Sound File hple3.mp 3 J
Sound Loops -1

If you want to add background sound to your flipbook, such as a song or other audio file, set "Enable
Sound->Enable", then click "] icon to choose "Sound File" from your computer, then set "Sound Loops",
"-1" stands for playing the sound file all the time while viewing flipbook, other value (N>0) stands for the
times of playing the sound file.

4, Tool Bar
E Tool Bar
Icon Color (o
[# Zoom Config
Print Enahle Yes
Search Button Hide

Search Highlight Color W 0x 408080
Least search characters |3
FHDownload setting
Full Screen Button Show
Help Button Show
[ Share Button
FHome Button
[ Auto Flip
Tool Bar on top False
Page Mumber Box On B... |False

(1) Tool bar (only in Classical Template)
Tool bar Shaw | Show or Hide Tool bar in created flipbook.

(2) Icon Color

Lcon Color [ oxFFrF = |
7T — = |
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(3) Zoom Config

ElZaom Config
Zoom in enable Yes

i Gt e s iy

To enable Zoon In functionality, choose 'Yes" in "Zoon in enable", you can set "Zoom Scale" in Classical
Template, the value is the times between zoomed page size and the current page size.

(4) Print Enable
Print Enable fes

Choose "Yes" in "Print Enable", then click icon to set print page range as below:

= Pnnt *

=) Print AN Pages
_J Print Current Page
_ Print Range

Exampie; 2,5,8-26

& Print

(5) Search Button:

Search Button Show

Search Highlight Caolor W ox4058030

Least search characters |3
Select "Show" in "Search Button" (make sure you have check "Enable Search" option in "Import Word"
interface), then define "Search Highlight Color" and "Least search characters", after clicking "Search" icon
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, you will see a popup box to input search words, then click Enter or "Search" button, you will get the
below searching result:

— b

T S - —
o ———
e e pa e e S G
e sy
e R ———
| EmrTE e e E—
R o e
e — e
— e atetn e Sy ——ty
P — gt W T
e

- e & e N

(6) Download setting:
BlDownload setting
Download Enable Yes
| Download urL PPTDemo.ppf

If you want your flipbook readers to download the Word file or the flipbook directly from your website,
select "Yes" in "Download Enable" option, then input the Download URL directly, you can use absolute path
like "http://www.flipbuilder.com/flip-Word/example/files/download/FlipWORDDemo.doc" or relative path
like "/files/download/FlipWORDDemo.doc" (make sure you have uploaded the WORD file to the same path).

Then readers can click the icon E to download your uploaded WORD file directly.

(7) Full Screen

To enable "Full Screen" functionality in output flipbook, select "Show" in "Full Screen Button" option:
Full Screen Button | Showe

Then you can click icon Eto view flipbook in Full Screen, click icon mor "Esc" button to exit from
the Full Screen.

Or if you want to show your flipbook without Tool Bar while showing in Full Screen mode, you can set "No"
in "Full Screen without Tool Bar" (just in Classical Template): ... Full Sereen Without Toal.. | Yes

(8) Help Button

To show tips about viewing flipbook, you «can set "Show" in "Help Button"
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option: Help Button Show

Then you can see the button and click to get the tips as below:
“ Help b 4

J Double click to Toom in orf out

\f Drag the page corner to wiew

(9) Share Button

If you want your flipbook viewers to send the link to their friends or clients, you can add a share button in
your flipbook for readers to send out your flipbook link immediately:
ElShare Button

Share Button Show
Email Subject Rear my fli...
Email Body fink}

When the viewers click the share buttonE, they will enter into the Email interface with the link of your
flipbook in the Email body.

(10) Home Button

You can add a home buttonm to help reader to click and go to your website directly:
ElHome Button
Home Button Visible Shaow
Page URL http: /flipbuil. ..
Open Window Blank

(11) Auto Flip

EAuto Flip
Enable Yes
Flip Interval 3
Play Count -1

Auto flip when startup |Yes

To auto flip your eBooks, you can set "Yes" in "Auto Flip->Enable" option; then define the Flip Interval
(seconds of staying on each page); the value of "Play Count" stands for the times of auto playing the eBook,

and "-1" stands for playing forever (after clicking the Auto Flip button “, the flipbooks will be flipped
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by staying 3 seconds per page); if you want to auto start and flip the eBook after opening, just set "Auto flip
when start up->Yes":

(12) Tool Bar on Top
Tool Bar on top True

(13) Page Number Box on Bottom
Page Mumber Box On B... |True

5. Initial Show (set in Float/ Spread Template)

You can show Bookmark panel or Thumbnails panel on the flash page at the beginning, just select
"Bookmark" or "Thumbnails" in this option:

For Example, select "Thumbnails":| Initial Show Thumbniais v|

Then you will get flipbook shown with below initial interface:

6. Bookmark
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Font color | [ ot A oy
Eanckground coior D'\:'lﬂdﬁ-\r we
Background sipha 1 iy

Desgn Setang | Back=ark

o & + + 4
T o trn gy Bsbioars bare
Title Fage

E About Flip Weed 2
| Product leshuet 3
'] Page-licping eBock feahres 5
) Quick Shart (3

. I!'_l Inilaifaees 4
] | Licenge Agieements 1
('] How to Ordes EE
7] Suppcet 1

In "Design Setting" panel (only in Classical Template, in other templates, the colors will be adjusted
automatically based on your defined flash window color), you can set "Font color", "Background color",
"Background alpha" (refers to the background opacity, value interval: 0~1, "0" stands for the background is
totally transparent), "Always Show Bookmark->True/ False" and "Panel Position->Left/ Right".

In "Bookmark" panel, if you didn't check "Import bookmark" option in "Import Word" interface, or you
want to create new bookmarks for your flipbook, you can add bookmarks even sub-bookmarks here, click
"Add" icons and then input "Title" and "Page".

When click the bookmark button, it will popup the bookmark panel immediately, and click on those
bookmarks, it will jump to the defined page automatically.

7. Links

|

If you have check "Import links" option in "Import Word" interface, then you can define settings here,
choose "Mouse over color", "Link alpha" (refers to the link area opacity, value interval: 0~1, "0" stands for
the area is totally transparent), "Border color", "Border width" and "Open Window->Blank/ Self". The links
also can be clicked after zooming by setting "Enable after Zooming in->Enable".
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8. Language
|_Lanquage Endglish |

You can set language for showing tools or tips in your created flipbook, and here is the specialized
instruction page for setting the "Language Option".

9. Security Settings

| Security Settings Single Pass |

If you want to protect your flash books with passwords, you can click "..." icon to enter into "Flash Security
Config" interface:

r@ Flash Secunity Config ﬁ

Mote:
Single Password opbion means that users need the password to view the flash book.

Exdude Front Pages oplon is to s2t a page number, alllatter pages can't be
vievred without inputting password.

Secuity Type

£ Ho Security
I |
AN ]
~ & Single Password: 123456
|
i Protect Page Range

" 0 All Pages
|l Exdude Front Pages
|
|
|
L

I Lo ] [ oo |

Select "Security Type->Single Password", and input passwords into the box (there is no restriction on
password format at present). You can also set "Protect Page Range" as "All Pages" or the latter pages after
a defined page number. (Tips: The program utilize RC4 algorithm to protect eBook pages, the eBook
content pages will show nothing without permission.)

10. Font
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Product features

Font Color |LIoxFFFF80
Button Font BritannigBold
Window Font Color

Window Font
Bookmark Font Color
Bookmark Font

License Agreements

How 1o Qirder

If you want to change fonts of toolbar buttons, flash windows even bookmarks, you can set font types and
colors in Font Panel.

11. Google Analytics

Google Analytics ID

In the HTML output format, you can add statistics by using google analytics. You can get more information
about Google Analytics ID from http://www.google.com/analytics/ .

ﬂ Apply Change

At last, click icon to apply the settings.

IV. Language Options Interface

Click "Option->Flash Language", you will enter into the Language Settings interface as below shows:
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You can new or edit a language for the flash fiipping book.
The Labled column below is the string that will be displayed in the flach,
w The language wil be st in the flash template settings

Language Settings
Label Labled =1 [ Edt
First Button First
Next Page Button Next Page |
Last Button Last
Previous Page Button Previous Page —h
Download Button Download
Prink Button Print
Search Button Search
Book Mark Button Book Mark
Help Button Help [
Enable FulScresn Button Enable FulScresn
Disable Fullsoeen Button  Disable FullScreen .
|G ed Py Bl by Sramyd M

Panel Description:

As the tips explaining, the "Labled" column lists the buttons and instructions on Flash books in defined
language, and the program provides you five different languages for you to use: English, Chinese Arabic,
French and Greek.

Language Mame: lw vl

Arabic

Chinese
French
Greek

You can also add other language for your own uses:

.
1. Click the button[ I Hew I‘E"”g“"a";“e]_and define name for the new language:
@Ne«unguage - g

New Langusge |

Name: French

Copy From: | English -

L ) (o]
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Click "OK" to save the new language in the list;

2. Choose the first label and click "Edit" icon, define new language text in "Labeled" box, then click "Save
And Edit Next":

Language Settings
Next Page Button 7. -
Last Button Last £ Editi Language tem ~ sl
Previous Pags Buttan Previous Pa r——————————=
Dewrload Buttan Donnkaad || EAtLanguage Sting |
Prinit Button Print
Search Buttsn search label:  FrstBuiton
Baok Mark Butten Boak Mark
Hslp Button Help {abelad;  |Premre]
Enable FulScreen Button  Enable Fulls
Disable Fulsreen Button Disable Ful
L Eniemdd Moy Bectbnn Sremd P
| sveaneatren | [ ox | [ conce

3. At last, you can get all Labels translated into your new language as the images shows:

Label Labled

First Button Premiére

Mext Page Button Page suivante
Last Button Derniére

Previous Page Button Page précédente
Download Button Télécharger

Print Button Imnprimer

Search Button Rechercher

Book Mark Button Réserver Mark
Help Button Aide

Enable FullScreen Button Activer FullScreen
Disable FullScreen Button Désactiver FullScreen
S T B e o Qrammd

e Delete
You can delete unwanted language:

Or save your edited new language file as XML or TXT file

33 Load...
Load language file saving before for current using:
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V. Output Interface:

E] Output Option ﬂ
Output |

Output type

@ =html © *gp {{‘%l © *.exe
@ :

Also Make Mobile Version Make output page-flipping eBook works on iPad, iPhone and Android mobile devices

Path
Qutput Folder: C:Wsers\Administrator\Documents ’ Browse. .. ] ’ Open
File Name: index .html
Options
HTML Title: Microsoft Word - Documentl
[CBum to CD

ter|0:1:0,G: PLDS  DVD-ROM DH-16D55 VD15

Make it automatically play the flipbook in CD

I Cancel l [ LConvert

Output types:
1. HTML
".;“3’ @ *.html
This output type is for uploading created page-flipping ebook onto websites:

You can define HTML Title and other properties by clicking "Advanced" button:
Options

HTML Title: demo

Set Keywords, Description or even Script in the below interface:
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Mwn“d Settings g
HTML Advanced SetBrgs
HITML Meta Settngs
Tite: Flip Word Introduction
Keywords:  cormeert, woed, doc, flipbook, page-fipoing, shack, flash, template, security

Description: | Fiip word is & tool to convert Word files to nicelpage-fiopng eBook with ease,

Add Scrpts

You can put soms traddng
code such a5 Google
Analytcs here,

Need dosed coeript>tag!

This output type is for compressing the created files into an integral ZIP package which can be sending out
as attachment directly. You can also define HTML Advanced Settings by clicking "Advanced"

|bE'u:h.=.r'r1u:u.l"ltr'nl

I::n:uok.swf

3. EXE

¥

This type is for outputting flipbook as a single executive file, easy storing and easy viewing:

P—
=

demao.exe

You can also define Icon and Opening Window Size in Advanced Settings:
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— t .
@ Advanced Settings &
Exe Advanced Settings |
Exe indon Info

Caption:  Fip Word Introduchon
Teon: iu_'l e | Defiit
Window Sze Opbon

& Mawmiped Custom Sae B ‘

Full Sereen

o ] [ coen |

You can even output Mobile Version at the same time:
Also Make Mobile Version
After creating mobile versions, you just need to output all files online (including HTML, SWF, "files" and

"mobile" folders), then you can visit the flipbook page through your mobile browser.

Or even burn the output flipbook to CD:

[#] Burn to D

CD Writer | 0:1:0,G: PLDS  DVD-ROM DH-16D55 VD15 +

Disc title: Page-Flipping eBook

[¥] Make it automatically play the flipbook in CD

After choosing output type, then check the option "Burn to CD", set "CD Writer", define "Disc title", at last

C t
click button to output flipbook in your defined type.
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At Last

With Word to Flash Brochure, you can easy create beautiful and professional page-
flipping eBooks within a few seconds.

Now, use the wonderful to produce your style stunning page-flipping eBooks.

For more information: http://www.flash-ebrochure-maker.com/
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